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About this book

Electrical warning icon indicates the presence of a hazard which could result in 
electrical shock.

Warning icon indicates the presence of a hazard which could result in personal 
injury.

Caution icon indicates important information or warning related to the concept 
discussed in the text. It might indicate the presence of a hazard which could 
result in corruption of software or damage to equipment/property.

Information icon alerts the reader to pertinent facts and conditions.

Tip icon indicates advice on, for example, how to design your project or how to 
use a certain function

This is not a reference manual, instead it describes the most common tasks and the 
workflow when working with recipes in the Formulation component.

Use of warning, caution, information, and tip icons
This publication includes Warning, Caution, and Information where appropriate 
to point out safety related or other important information. It also includes Tip to 
point out useful hints to the reader. The corresponding symbols should be 
interpreted as follows:
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Although Warning hazards are related to personal injury, and Caution hazards are 
associated with equipment or property damage, it should be understood that 
operation of damaged equipment could, under certain operational conditions, result 
in degraded process performance leading to personal injury or death. Therefore, 
comply fully with all Warning and Caution notices.

Terminology
The Glossary contains terms and abbreviations that are unique to ABB or have a 
usage or definition that is different from standard industry usage. Please make 
yourself familiar to that.

You will find the glossary at the end of the Engineering Manual System 
Configuration.

Document conventions
The following conventions are used for the presentation of material:

• The words in names of screen elements (for example, the title in the title bar of 
a window, the label for a field of a dialog box) are initially capitalized.

• Capital letters are used for the name of a keyboard key if it is labeled on the 
keyboard. For example, press the ENTER key.

• Lowercase letters are used for the name of a keyboard key that is not labeled on 
the keyboard. For example, the space bar, comma key, and so on.

• Press CTRL+C indicates that you must hold down the CTRL key while 
pressing the C key (to copy a selected object in this case).

• Press ESC, E, C indicates that you press and release each key in sequence (to 
copy a selected object in this case).

• The names of push and toggle buttons are boldfaced. For example, click OK.

• The names of menus and menu items are boldfaced. For example, the File 
menu.

– The following convention is used for menu operations: MenuName > 
MenuItem > CascadedMenuItem. For example: select File > New > Type.
10  Engineering - Formulation
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– The Start menu name always refers to the Start menu on the Windows 
Task Bar.

• System prompts/messages are shown in the Courier font, and user 
responses/input are in the boldfaced Courier font. For example, if you enter a 
value out of range, the following message is displayed:

Entered value is not valid. The value must be 0 to 30. 

You may be told to enter the string TIC132 in a field. The string is shown as 
follows in the procedure:

TIC132

Variables are shown using lowercase letters.

sequence name
 Engineering - Formulation 11
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1  Overview

1.1 Introduction
Formulation is an essential Recipe Management component for single product or 
multi-grade product process cells controlled by Freelance process stations. The 
recipes are executed on a single Sequential Function Chart [SFC] and only one 
recipe can run on a SFC at any time. 

Multiple Recipes may run on different SFCs at the same time.

The database used to store the recipes can be shared among several Formulation 
workstations.

The Formulation database supports recipes for up to 70 SFCs with max 30 Master 
Recipes for each and 30 Control Recipes per Master Recipe. Each recipe can have 
up to 300 parameters and report items.

Once a recipe has been executed Formulation will run a simple batch report based 
on an Excel sheet.

Formulation is not a batch package for multi-product multi-path, sophisticated batch 
applications. 

For those requirements ABB offers 800xA Batch.
 Engineering - Formulation 13
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2  Installation

2.1 General
This section describes the installation of Formulation. 

Formulation can be installed in different topologies (see picture below). 

Installation_Topologies.png

Formulation needs the Freelance environment. Therefore always install 
Formulation on a PC with an existing Freelance Engineering and/or Freelance 
Operations installation.
 Engineering - Formulation 15
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2.1.1 Stand-alone

This topology is usually used with a single Formulation station, but multiple 
installations in a system are possible.

Formulation is installed as server, but only the local client (that comes with the 
server) will access its database. If installed multiple times in a system the databases 
are independent. Recipes cannot be shared among the databases. If the same recipe 
needs to be on different databases it has to be configured on each Formulation 
station separately.

2.1.2 Client/Server

Here one station is installed as a server; the other Formulation workplaces are 
installed as clients. All access the same database, thereby sharing all the recipes.

2.2 First Installation
After you have decided about the installation topology the installation is straight 
forward.

Formulation is an auxiliary option of Freelance. Install Formulation by ticking the 
Formulation checkbox during the Freelance installation process. User needs to 
restart the computer to complete the installation. 

If different clients modify the same record in the database (same instance of 
Master Procedure, Master Recipe, Control Recipe, Parameter, Report Item) at the 
same time, the last modification wins. 

Locking of records is not supported.

Before doing configuration changes in a Client/Server environment from a client 
workplace do a manual refresh. Press the refresh button . This makes sure 
you get the latest updates from the database.

For client/server installations with mixed 32-bit and 64-bit operating systems 
reporting will not work due to different default template directories on client 
(running a batch) and server (creating the Master Recipe). In such a coinstallation 
create your own non default template directory (same on client and server).
16   Engineering - Formulation
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 Formulation Installation

2.2.1 Server Station

This will install a fully functional Formulation program including a database that 
keeps all information about the recipes. The database can be used by client station 
installations.

The setup will share the data file directory of Formulation to “everyone” with read 
and write access rights. The shared directory is called “Formulation”. By default the 
Formulation installation directory is:

C:\Program Files\ABB\Formulation (For 32-bit OS)

C:\Program Files (x86)\ABB\Formulation (For 64-bit OS)

And the default data file directory is:

C:\FreelanceData\Formulation
 Engineering - Formulation 17
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We should keep in mind that people who make changes to the database (users who 
insert recipes, advance life cycle, edit data, create control recipes...) need “Read” 
and “Write” permission. 

After successfully sharing the database directory you can see the share network path 
in the properties dialog of the Formulation directory on the “Sharing” tab.

Data file sharing

The network path has the form of \\<server name>\<file name>, where 
<server name> is the computer name and <file name> is the share name of the 
directory. 

Formulation V1.3 can be installed on the PC running Windows 10 and Windows 
7.
We strongly recommend to restrict the access to certain users. Please revert to 
Windows “Help and Support” in the Start menu. You might want to look for 
“File sharing essentials” and “Share files with someone”.
18   Engineering - Formulation
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In above example the computer name is DESKTOP-CD3809R and the share name 
is “DBFile”.

2.2.2 Client Station

This will install the Formulation program without a database. When opening 
Formulation for the first time, it is necessary to set up the link to the remote database 
on the server station.

To set up the link, first map the network drive from the server station that has been 
shared. Revert to windows “Help and Support” in the Start menu to find out how to 
do this. You might want to look for “Create a shortcut to (map) a network drive” to 
get a description on how to map a network drive.

 Map network drive.png

Use any free drive letter and remember to check the Reconnect at Logon. 

The “Connect using different credentials” checkbox should be unchecked. That 
way the current logged in windows user will connect to the shared directory.

Click Finish and after a short while the file explorer should open a window of the 
remote directory. Close that window because we do not need it.

After the map has been created successfully start Formulation.

Please note down the network path for your installation, you will need it for 
pointing the clients to their remote database.
 Engineering - Formulation 19
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For the first time to launch Formulation client, a dialog pops up asking for mapping 

to the database. Map the directory as required and click Open.

Map database

After the first mapping of the database, if user wants to change the database 
directory, user needs to go to File > Change Database when next time Formulation is 
running.

Click open and Formulation will remember the path to the remote database on this 
client.

Close Formulation. On the next start Formulation will use the mapped remote 
database.

File > Change Database...

Browse to mapped directory (you can find it under Computer with the drive letter 
used during the mapping) and select the database file “Formulation.mdb” in the 
DBFile subdirectory. 
20   Engineering - Formulation
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2.2.3 Install Excel for Reports

Formulation uses Microsoft Excel for reporting. In order for the reporting to work 
Excel 2003 or higher needs to be installed on the PC that downloads the Control 
Recipes. See Download the Control Recipe on page 102. 

2.3 Formulation Upgrade
For Formulation V1.0 to V1.2,  it is possible to install the Update over your current 
installation of Formulation, without un-installing the older version first. If you 
intend to update Formulation from older version, click “Yes” after starting the 
Setup.exe from the Formulation CD. Follow the instructions to complete the update 
process. Update will have no effect on Client/Server mode or database.

From Formulation V1.3 on, upgrade from the previous Formulation version is no 
longer possible. An un-install of the previous Formulation version is required before 
installing the latest version.

2.4 Uninstall
From Formulation V1.3 on, Formulation setup is merged with Freelance installation 
package.

To uninstall the Formulation software:

Formulation can be used with following Freelance revisions:

• Formulation V1.3: Freelance 2019 

• Formulation V1.2: Freelance 2016 SP1

• Formulation V1.1: Freelance 2016

• Formulation V1.0: Freelance 2013 and Freelance 2013 SP1

Windows Control Panel > Programs > Uninstall a program 

or go to the Freelance installation package, 

Installer > Modify
 Engineering - Formulation 21



Formulation License 2  Installation
 Uninstall

The setup will ask whether the database should also be removed.

2.5 Formulation License
Running Formulation required a hard key and an authentication key. Without these 
two, the Formulation is not allowed for professional purposes and can not be started.

License error

If you select to let setup remove your database, all recipes will be lost.
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If Formulation is required for your project, please contact your local ABB service, 
and configure the authentication key in Settings tool.

License setting 
 Engineering - Formulation 23
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3  Terminology

This chapter defines certain terms used throughout this document.

Term Description

SFC Abbreviation for "Sequential Function Chart", one of the 
programming languages of the IEC61131-3. This lan-
guage is used to describe sequential flows of actions 
controlled by transitions and ideal for batch applications 
or recipes.

Master Procedure The Master Procedure represents the SFC in the ISA 
S88 world of Formulation. It contains a short description 
of SFC attributes and is hierarchically the father of Mas-
ter Recipes. Each Master Procedure can only have one 
SFC in Formulation.

Up to 70 Master Procedures are supported by Formula-
tion.

Analog: The Master Procedure corresponds to kitchen 
equipment (like oven with temperature setting capability) 
and procedural workflow Know-How (like which steps to 
perform to boil water) of a house wife.
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Master Recipe The Master Recipe contains the ingredients and their 
amounts as well as other parameters (like reaction dura-
tion, reactor temperature etc) to produce a norm amount 
of the product. 

Up to 30 Master Recipes are supported per Master Pro-
cedure.

The Master Recipe is hierarchically the father of Control 
Recipes

Analog: The Master recipe can be compared to a recipe 
in a cook book of the house wife. The recipe contains in-
gredients for a fixed number of persons.

Control Recipe The Control Recipe contains similar information like the 
Master recipe, but for an actual amount of product to pro-
duce which usually differs from the norm amount the 
Master recipe is specified for.

When the Control Recipe is downloaded to the controller 
it becomes a Batch. The Control Recipe carries a Batch 
ID and occupies the single SFC of its belonging Master 
Procedure when it is executed.

Analog: While the recipe in the cook book contains the 
ingredients for let's say 2 people, the house wife needs to 
adapt those amounts when cooking for a party with 20 
people. Her shopping list to cook for 20 people corre-
sponds to the Control Recipe, while the process of cook-
ing the meal for the 20 people corresponds to the batch 
executing on the SFC.

Batch The word Batch is used for the process of creating the 
product as well as for the amount of product created.

Term Description
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Formulation Mode Formulation supports 2 modes: Configuration and Oper-
ation.

In Configuration mode, Master Procedures and Master 
Recipes can be configured and their life cycle can be ad-
vanced.

In Operation mode, Control Recipes can be created and 
downloaded to run the batches.

The mode Formulation is running in can easily be 
detected by the background color and the highlighting of 
the mode buttons.

Life Cycle Master Procedures, Master Recipes and Control 
Recipes can be in different states during their life time. 
The sequence of those states is called a life cycle. 

Example: A Master Procedure goes from Draft to
Released to Withdrawn.

Scaling The amount of product to create will mostly differ from 
the amount specified in the Master Recipe. Therefore the 
values for the ingredients given at the parameters of the 
Master Recipe need to be adjusted to fit to target 
amount. This adjustment is called scaling.

Term Description
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4  Use of Formulation

4.1 Preparing your project for the use of Formulation
Recipes are using Sequential Function Charts and FPX function blocks on the 
controller to execute batches. Sequential Function Charts and FPX function blocks 
are configured using Freelance Engineering. Formulation needs to know about those 
objects because it needs to communicate with the controller to write recipe 
parameter values into variables and show their current values.

Formulation is represented in the Freelance Engineering project with a UNI-
Gateway. If a download is executed from Freelance Engineering to the UNI-
Gateway, the corresponding Formulation workplace gets informed about existing 
SFCs and FPX function blocks and has access to variables that hold parameters and 
report values.

4.1.1 Adding a UNI-Gateway to the project

For each workplace that wants to run the Formulation software a 
UNI-Gateway needs to be added to the project.

The UNI-Gateway software is started when Formulation starts. This means in 
order to get a connection to a specific UNI-Gateway instance the corresponding 
Formulation executable needs to run.
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 UNI Gareway.png

Example: If you want to install a Formulation server plus two Formulation clients 
you need to add 3 UNI-Gateways to the project.

Write access must be set up for the UNI - Gateways. Write access configuration 
steps: right click Gateway station > select Header >Access rights > Tick Write 
checkbox.

Each UNI-Gateway counts as one against the 10 clients limit of a process station. 
In the boot parameter dialog of a process station, "Number of operator stations" + 
"Number of gateway stations" cannot exceed 10.
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If you need to change the configuration of “Number of operator stations” or 
“Number of gateway stations” in the boot parameter dialog of a process station to 
accommodate for the increased number of Gateways (“Number of gateway 
stations”) the system needs to initialize the resource before the change will take 
effect. This means the process station will boot and a “Load/Whole Station” is 
needed afterwards.

 Boot_parameters.png

Next step is to configure which variables and tags can be accessed by the UNI-
GWYs.

Variables

Call up the Variable List in Freelance Engineering and switch to the Station View. 
Then give RW-access to all variables that hold recipe parameters and R access only 
to all variables that hold report values. Remove all access for every other variable. 
For more information, refer to 3BDD012504 Engineering Manual IEC 61131-3 
Programming, Variables, Editing Variable List, sub-sections Normal View and 
Station View.
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 Station_View_Variable list.png

Use the filter capabilities of the Variable List to reduce the list to structured data 
types only (if you followed the recommendation to use structured data types), 
that will help to find the right variables faster.

Tags

Call up the Tag list in Freelance Engineering and switch to Station View. Then in 
the columns for the UNI-GWYs that where added give RW access to all FPX type 
tags, and SFCs to be used for recipes. Remove all access for the rest of the tags in 
these columns. For more information, refer to 3BDD012504 Engineering Manual 
IEC 61131-3 Programming, Tag List, Editing Tag List, sub-sections Normal View 
and Station View.

Use the filter capabilities of the Tag List to reduce the list to FPX type tags and 
SFCs only that will help to find the right tags faster.
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Network Configuration

After all gateway stations have been added and configured, the network 
configuration needs to be adjusted.

Network Configuration.png

IP Address For each UNI-Gateway enter the IP address of a PC on which you 
installed the Formulation software, regardless whether it was a 
server or a client installation. 
The column IP address 2 is reserved for redundancy, which is not 
supported Formulation currently.

Resource ID Set a unique Resource ID for each UNI-Gateway that you have 
added. The resource ID is needs to be set at two locations. One is 
here in the network configuration; the other is at the PC where the 
Formulation software was installed.

Freelance Engineering will connect to each Formulation installation (the UNI-
Gateway) by using the information given in the network configuration dialog. So 
make sure that the combinations of Resource ID and IP address entered in the 
network configuration dialog match the resource ID configured in the preferences 
dialog in the Formulation software running on the PC with that IP address. See also 
Configure the GWY resource ID on page 45.
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4.1.2 Using FPX Function block for each SFC

Each recipe/batch runs on a single SFC. Formulation uses a FPX function block to 
determine the state of the batch. Therefore each SFC that is intended to be used with 
Formulation needs to have a FPX function block configured.

For more information on how to configure a FPX function block, refer to 
3BDD012514 Engineering Manual Functions and Function Block, Batch 
Control Function Blocks 

The FPX is used by Formulation to determine whether a SFC is available for 
downloading a control recipe. If the FPX is in idle state and in Program mode, 
Formulation will allow downloading a control recipe.

More details about how the FPX is used by Formulation can be found in Download 
the Control Recipe on page 102. 

4.1.3 Using Structured Data Types and Report Items

Each recipe can provide up to 300 parameters and 300 report items. When 
“downloading” a control recipe the values of the control recipe parameters are 
written to variables in the controller. When creating the batch report, the values of 
the variables holding the report items are read from the controller.
The outputs of the FPX function block (max 20) cannot be used, because of the high 
number of recipe parameters. Instead Formulation writes and reads directly global 
variables from a controller.

While it is possible to use standard variables in the controller for the parameters and 
report items, Formulation provides a benefit when using structured variables 
instead. The configuration effort in creating a recipe is drastically reduced. 
Formulation allows selecting a complete structured variable when adding 
parameters to a recipe. 

Because a structure variable can have up to 256 components, selecting a structured 
variable when adding parameters to a recipe will add up to 256 parameters in one 
action. 

With Formulation the parameters of the batch are not provided on the outputs of 
the FPX function block, therefore those should not be configured in the 
parameter mask of the FPX function block. See also Using Structured Data Types 
and Report Items on page 34.
34   Engineering - Formulation



4  Use of Formulation Using Structured Data Types and Report Items
 

In most cases a single structured variable for parameters and another structured 
variable for report items will be enough. In case the recipe requires more than 256 
parameters or 256 report items, additional structured variables will be needed.

Structured_Variables_Directly.png

For information on how to configure a structured variable, refer to manual 
3BDD012504 Engineering Manual IEC 61131-3 Programming, Variables, 
Structured Variables. 

In case the SFC was already configured earlier using standard variables there is still 
the possibility to add a program that assigns components of a structure variable to 
the standard variables used in the SFC. That way the benefits of structured variables 
with Formulation can be used without rewriting the code of the SFC.
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Structured Variables Indirectly.png

Assigning Structured Variables.png
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The same can be applied for report items, when assigning the standard variables to 
the components of a structured variable containing the report items.

4.1.4 Integrate Formulation with Freelance Operations

In order for the operator to be able to use Formulation from the context of Freelance 
Operations it is recommended to configure an External Aspect for all FPX function 
blocks used by Formulation.

For information on how to configure an external aspect, refer to document 
3BDD012518, Engineering Manual Operator Station Configuration, Standard 
Displays, Display access. 

The command line to start Formulation is:

Formulation.exe "(Mode, User, FPX Tag Name)”

Mode: Mandatory

Configuration Formulation will open in mode Configuration provided the user 
has matching access rights.

Operation Formulation will open in mode Operation provided the user has 
matching access rights

User: Provide

– the name of a single user, 
or

– leave empty (recommended)

Those assignments should not happen in a step in the SFC but happen outside the 
SFC, otherwise changing recipe parameters while the batch runs will not have 
any effect on the variables used by the batch and report values will not change 
while the batch runs.
Best put the assignments in the same program that holds the FPX for the SFC.

The setup has set the path to the Formulation installation directory in the 
Windows environment, so not path information is needed as part of the file name.

There is a blank between Formulation.exe and the opening
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See Login behavior with External Aspect on page 40 for details

FPX Tag Name Name of an FPX function block. When used, together with 
Mode=Operation, Formulation will open up with the parameter 
view of the Control Recipe running on the belonging SFC. This is 
useful to control or change parameters of a running batch. If no 
control recipe with a life cycle “Ready” or “Executing” does exist 
for the belonging SFC then Formulation will open up with the 
Master Procedure selected that belongs to the FPX function block.

If left empty, Formulation will open in the corresponding mode 
selected by “Mode” with the root node selected.

Examples:

• Formulation.exe “(Configuration,,)”
This will call up Formulation in Configuration mode. The root node will be 
preselected.

• Formulation.exe “(Operation,,FPX_Bakery)” 
This will call up Formulation in Operation mode. If the SFC belonging to 
FPX_Bakery is in “Ready” or “Executing” life cycle state, then Formulation 
will open with the corresponding control recipe preselected. The tree pane will 
be hidden (Auto hide).

4.2 Starting Formulation
You can start Formulation in different ways.

On an Engineering Workplace:

On the Engineering PC or without Freelance Operations running, click on the 
Formulation icon on your desktop.

On an Operator Workplace:

Freelance Operations for security reasons prevents accessing the desktop, especially 
if “Auto start” is configured for Freelance Operations in a production environment.

Here you can either add Formulation to the Startup folder (look up “Run a program 
automatically when Windows starts” in Windows Help and Support how to do this) 
and then access it after Freelance Operations has started with ALT+TAB, or use 
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External Aspects to start Formulation from the context menu of a Tag faceplate. The 
latter is described in Integrate Formulation with Freelance Operations on page 37. 
The latter is recommended, because it restarts Formulation in case you have closed 
it accidentally.

4.3 Login and Logout
For the current version of Formulation, the user currently logged into Freelance 
Operations is not known to Formulation. Therefore when Formulation starts and 
User Management is enabled, Formulation will ask the user to login.

Login_ dialog.png

Type the user name in the  field and the password in the  field, then click the 
Login.

Formulation will verify the credentials given using the configuration of users, 
groups and permissions done with User Management. See also Set Access rights on 
page 40, for details about permission handling.

When you click the logout  the current user will be logged out of Formulation 

and the default user “GUEST” will automatically be logged in.

Logout is not necessary to switch to a new user. Simply click the login/ log 
over  and the login dialog will come up allowing a new user to switch in.
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4.3.1 Login behavior with External Aspect

Configuring Formulation as an external aspect allows the passing of a User 
parameter. See Integrate Formulation with Freelance Operations on page 37, for 
details about configuring an External Aspect to start Formulation.

If User is left empty (recommended) then Formulation will ask for the user’s 
credentials whenever the External Aspect is executed.

If a User (name) is specified, Formulation will not ask for the user’s credentials, 
provided that user is already logged into Formulation.

4.4 Closing Formulation
As long as Freelance Operations is running, Formulation will only minimize when 
the user tries to close it. This prevents reports from getting lost and Formulation 
from being out of sync with the FPX function blocks.

After Freelance Operations is closed, Formulation can also be closed normally. 
Formulation will not close automatically when Freelance Operations is closed; 
rather it has to be closed separately.

4.5 Preparing the Formulation to work with the project 
Some initial configuration needs to be done, when running Formulation for the first 
time.

4.5.1 Set Access rights

Formulation supports both scenarios:

– Using access rights 

– Not using access rights

Formulation will detect if User Management is enabled and switch to using access 
rights. If User Management is not enabled on the PC Formulation will not support 
access rights. 

The use of access rights is recommended, if you are concerned about security. 
Formulation uses access right configuration done with User Management and 
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enhances it with permissions special to recipe management. User Management 
contains Security Lock and Extended User Management for access control.

Using Access Rights with Security Lock

Make sure that Security Lock is enabled on the PC and that already groups with 
their system permissions have been configured and users have been assigned to the 
Groups.

Formulation uses the system permissions for Configuration (CONF), 
Commissioning (COMM) and for running Security Lock (Lock) given to user 
groups configured in Security Lock and adds permissions for viewing (only), 
operating and approving recipes.

To open the configuration dialog, click on symbol 

Access rights_configuration dialog.png

If Security Lock is enabled a user that wants to configure access rights in 
Formulation needs to be part of a group that has “Lock” permission.
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The groups shown are read from the UID file created by Security Lock on the local 
PC. The Columns “Configure”, “Commission” and “Lock” show the values already 
configured for those groups using Security Lock. The values (checkmarks) of those 
3 columns and the groups cannot be changed within Formulation. Use Security 
Lock to change any permission in those three columns or to add/modify/delete 
groups.

Permissions to view, operate and approve within Formulation can be set in the 
Access Rights Configuration Dialog.

Formulation interprets the permission for “Commission” slightly different from 
Freelance Engineering. For Formulation the permission to do commissioning 
includes the permission to configure. Therefore whenever a group has permission 
to do commissioning it will also be shown to have permission to configure.

Reason is that Formulation does not have a separate commissioning mode like 
Freelance Engineering. In order to execute the commissioning permission in 
Formulation, a user runs Formulation in Configuration Mode.

Permission Allows to Needed in Mode

Configure Create, modify, and delete Master Pro-
cedures and Master Recipes. Advance 
life cycles for Master Procedure and 
Master Recipes.

For approval of Master Recipes addi-
tional permission "Approve" is neces-
sary. For setting a Master Recipe effec-
tive additional permission “Commission” 
is needed.

Configuration

Commission Deploy a Master Recipe (Advance the 
life cycle from “Released” to “Effective” 
and vice versa).

Only a deployed Master Recipe can be 
used by an operator to create Control 
Recipes.

Configuration

Lock Configure permissions for “Approve”, 
“View” and “Operate” 

Configuration
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When Access Rights are used, life cycle changes need a “signature” by a user. The 
“signature” means the user needs to provide Name and Password again even 
though he might be locked in.

Using Access Rights with Extended User Management

With Extended User Management (EUM), Formulation supports user login with 
windows accounts. User can select either Use Local Account or Use Domain 
Account to access Formulation.

Extended User Management distributes the permissions by allocating users to 
different Windows user groups. Create users and user groups on a local computer or 
on a domain server to manage the user access. For more information on how to 

Approve Sign the approval of a Master Recipe.

The advance of the life cycle to “Ap-
proved” can be started with “Configure” 
permission, but the person to sign with 
Name and Password needs “Approve” 
permission. Without this signature the 
life cycle will stay in “Draft”.

Configuration

View See all recipe information. No change is 
permitted

Operation

Operate Can create, check, modify download 
and delete Control Recipe. Change pa-
rameters.

This permission is necessary to run a 
batch.

Note:Downloading a Control Recipe 
does not need “Commission” permis-
sion, because it actually means writing 
variables in the controller only. No 
download in the sense of Freelance 
Engineering happens.

Operation

Setting the permission for Operate will automatically also set the permission for 
View because View access is needed for operation.

Permission Allows to Needed in Mode
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create users and user groups on local computer or on a domain server, please refer to 
Engineering Manual User Management. 

The permissions for different Windows user groups are listed below.

Group Name Description

ABB Freelance Basic Ac-
cess

Mandatory group, every Freelance user has to be in 
this group.

ABB Freelance Configure Create, modify, and delete Master Procedures and 
Master Recipes. Advance life cycles for Master Pro-
cedure and Master Recipes.

For approval of Master Recipes additional permis-
sion "Approve" is necessary. For setting a Master 
Recipe effective additional permission
“Commission” is needed.

ABB Freelance Commis-
sioning

Deploy a Master Recipe (Advance the life cycle from 
“Released” to “Effective” and vice versa).

Only a deployed Master Recipe can be used by an 
operator to create Control Recipes.

ABB Formulation View See all recipe information. No change is permitted

ABB Formulation Operate Can create, check, modify download and delete 
Control Recipe. Change parameters.

This permission is necessary to run a batch.

Note: Downloading a Control Recipe does not need 
“Commission” permission, because it actually 
means writing variables in the controller only. No 
download in the sense of Freelance Engineering 
happens.

ABB Formulation Approve Sign the approval of a Master Recipe.

The advance of the life cycle to “Approved” can be 
started with “Configure” permission, but the person 
to sign with Name and Password needs “Approve” 
permission. Without this signature the life cycle will 
stay in “Draft”.
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Enable Extended User Management

• Run Settings tool.

• Go to User Management, select Enable User Management and choose Use 
Extended User Management.

• Select the login account, and select Single Sign-on if you want to login 
Formulation automatically.

Single Sign-on will automatically log user in with current windows account when 
Freelance Engineering, Freelance Operations or Formulation runs.

• Click Apply and then OK to save the configuration.

With Extended User Management enabled, user can log in Formulation with 
Windows account if the account is correctly configured.

Not using Access Rights

User Management is not needed. Configuration of recipe access permissions is not 
supported. Life cycle changes do not need any “signature”. The user that appears in 
the life cycle table is the default system user “NOLOCK”.

Every user can do everything in Configuration or Operation mode.

4.5.2 Configure the GWY resource ID

The setup of Formulation will set the default Resource ID to 100. In case you have 
multiple Formulation installations in a system make sure that each Resource ID is 
unique. In other words only one station is allowed to have 100 as its Resource ID. 
For the other stations you will have to enter different Resource IDs.

With Extended User Management, the user access is managed by different user 
groups, therefore, the Access Configuration item under Access Tab in 
Formulation interface is not configurable. User can only change access rights by 
assigning user to specific user groups.
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In each Formulation, installation call up the Preferences dialog through the menu 

Resource_ID.png

The pair of Resource ID and IP address for a station must match the entries in one 
line in the network configuration dialog in Freelance Engineering.

The new Resource ID will become effective only after restarting Formulation

4.6 Backup the Formulation data
Before you begin to fill the recipe database think about backup. All data is saved in 
the file. Formulation.mdb in the DBFile directory under the installation directory of 
Formulation. By default, the data file directory is: 

C: \FreelanceData\Formulation

And the default installation directory is:

C:\Program Files \ABB\Formulation (For 32-bit OS)

C:\Program Files (x86)\ABB\Formulation (For 64-bit OS)

 If the installation was done to a different path, replace the default paths in the 
following with the changed installation path.

What you need to backup depends if the installation is a client or a server station.

Tools > Define Resource ID and set a unique Resource ID.
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Files to backup on each client station:

C:\FreelanceData\Formulation\Config.ini

All files in C:\FreelanceData\Formulation\Template

All files in C:\FreelanceData\Formulation\Report

C:\FreelanceData\digimat.UID

Files to backup on the server station

C:\FreelanceData\Formulation\Config.ini

All files in C:\FreelanceData\Formulation\DBFile

All files in C:\FreelanceData\Formulation\Template

All files in C:\FreelanceData\Formulation\Report

All files in C:\FreelanceData\Formulation\Log

C:\FreelanceData\digimat.UID

From Formulation V1.1 on, a Master Recipe can be archived on the server station. 
For details, please refer to the section Archive a Master Recipe on page 82.

4.7 Restore the Formulation data
In a Client/Server installation only the server has the database with the recipes. If 
the database is corrupt, restore the proper files in the server station.

4.7.1 On a Server Station

If the database becomes corrupt, restore all files in:

C:\FreelanceData\Formulation\DBFile

If the program does not start or crashes all the time, start the setup and do a repair 
installation.

After the repair restore the following from your last backup:

Make sure you select to keep your database when the Repair program asks you 
about it.
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Freelance and Formulation share the DIGIMAT.UID file. Be sure to restore only 
the latest version from either the Freelance backup or Formulation backup, 
whichever has the latest version.

 

C:\FreelanceData\Formulation\Config.ini

All files in C:\FreelanceData\Formulation\Template

All files in C:\FreelanceData\Formulation\Report

All files in C:\FreelanceData\Formulation\Log

If after the repair Formulation continues to not start or crash, do a second repair, but 
this time choose to overwrite your database. Then restore the following from your 
last backup:

C:\FreelanceData\Formulation\Config.ini

All files in C:\FreelanceData\Formulation\DBFile

All files in C:\FreelanceData\Formulation\Template

All files in C:\FreelanceData\Formulation\Report

All files in C:\FreelanceData\Formulation\Log

For a new installation after a corrupted disk, first install Freelance new and restore 
your project, then install Formulation. Afterwards restore the following from your 
last backup over the files from the installation:

C:\FreelanceData\Formulation\Config.ini

All files in C:\FreelanceData\Formulation\DBFile

All files in C:\FreelanceData\Formulation\Template

All files in C:\FreelanceData\Formulation\Report

All files in C:\FreelanceData\Formulation\Log

C:\FreelanceData\digimat.UID

4.7.2 On a Client Station

If the program does not start or crashes all the time, start the setup and do a repair 
installation.
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Freelance and Formulation share the DIGIMAT.UID file. Be sure to restore only 
the latest version from either the Freelance backup or Formulation backup, 
whichever has the latest version.  

After the repair restore the following from your last backup:

C:\FreelanceData\Formulation\Config.ini

All files in C:\FreelanceData\Formulation\Template

All files in C:\FreelanceData\Formulation\Report

For a new installation after a corrupted disk first install Freelance new and restore 
your project, then install Formulation. Afterwards restore the following from your 
last backup over the files from the installation:

C:\FreelanceData\Formulation\Config.ini

All files in C:\FreelanceData\Formulation\DBFile

All files in C:\FreelanceData\Formulation\Template

All files in C:\FreelanceData\Formulation\Report

C:\FreelanceData\digimat.UID

4.8 Create a Master Procedure
1. Start Formulation.

2. Make sure the mode Configuration is selected

3. Right-click on Root node in the tree

4. Select Insert M.Procedure from the context menu

A new Master Procedure [MP] with the default name New Master Procedure will 
be created. The tab M. Procedure Header is preselected.
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 Master_Procedure_Header.png

As a minimum the 4 elements marked with “*” in above picture plus the Version 
should be filled out.

M.Procedure Provide a meaningful name for the Master Procedure. Selecting a 
unique name makes it easier to find the right Master Procedure later. 
The name can be up to 64 characters long.

FPX Tag Name 
Select the name of the FPX function block associated with the SFC 
that runs the recipe. This FPX will be monitored by Formulation to 
decide if a SFC is available and to detect the state of the batch.

Version Provide a version for the draft of the Master Procedure like “D1.0”. 
Formulation does not imply any syntax or force any rule on the 
version string. The version can be up to 8 characters long.

Process Station 
Select the process station from the list on which the SFC runs that 
represent the recipe.
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Capacity Set minimum and maximum capacity that can be produced by the 
SFC in one batch. This value should represent the physical 
limitations of your equipment. It is used later to decide if more than 
one Control Recipe needs to be created to produce the wanted 
amount. 
Set the unit for the batch. If you cannot find the unit in the list, type 
a new one.

Optional header information is:

Description Holds up to 256 characters that describe the recipe.

SFC Display Fill in the name of the SFC-Display that belongs to the SFC. This is 
for information purposes only. It might be used in a later version of 
Formulation to activate the corresponding display.

Life Cycle This is filled automatically with the name of the user that created 
the recipe and date and time of the creation.

Project File Specify the name of the Freelance Engineering project file. For 
reference purposes only.

Project Path Specify the path to the directory where the project file resides. For 
information purposes only.

Project Version This is filled automatically with the 3-tuple of the project version 
for the selected process station at the time of the creation of the 
Master Procedure. This project version can also be seen in the 
Freelance Engineering in commissioning mode when selecting the 
same process station and select Load > Version informations…
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Version_Information.png

This is useful to determine, if the process station has been modified since the 
creation of the Master Procedure, which might affect the recipes.

Press Apply to save the changes that you made.

4.9 Advance the Life Cycle of Master Procedure
Right-click on a Master Procedure in the tree and select the Life Cycle entry to see 
the possible commands available for advancing the Master Procedure’s life cycle.
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Master_Procedure_Lifecycle _commands.png

A Master Procedure has 3 life cycle states: Draft, Released and Withdrawn.

Draft 

This is the state directly after creating a Master Procedure and during editing. It is 
not possible to create a Master Recipe while the belonging Master Procedure is still 
in draft.

Released 

This is the normal state of a Master Procedure. In this state Master Recipes can be 
created for the SFC that is represented by the Master Procedure.

A released Master Procedure cannot be deleted. It has to be moved into the 
Withdrawn state first.

Once a Master Recipe has been released, it cannot be brought back to Draft state 
anymore. If a released Master Procedure is edited and the Apply button is pressed 
Formulation will create a copy of the released Master Procedure instead, with the 
changes applied. The copy will be set to draft state. The name of the copy will be 
the name of the source Master Procedure with “-Copy(#)” added, where “#” is a 
counter that is incremented for each copy.
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Withdrawn 

This life cycle state is used to out-phase a Master Procedure. It is only possible to 
withdraw a Master Procedure when all its children (Master Recipes) are in 
Withdrawn state. In this state it is possible to delete a Master Procedure. It is 
necessary to delete existing children before the Master Procedure can be deleted 
itself.

Mtr_Pro_ Life_ Cycle .png

4.10 Create a Master Recipe 
1. Start Formulation.

2. Select the mode Configuration. 

3. Select a Master Procedure in Released state

4. Right-click on the Master Procedure to show the context menu
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5. Select Insert Master Recipe from the context menu

A new Master Recipe [MR] with the default name New Master Recipe will be 
created. The tab MR Header is preselected.

Master Recipe Header Data.png

As a minimum the 2 elements marked with “*” in above picture plus Version and 
Report Generation should be filled out.

Master Recipe Name 
Provide a meaningful name for the Master Recipe. Selecting a 
unique name makes it easier to find the right Master Recipe later. 
The name can be up to 64 characters long.

Report Generation 
Check this box if Formulation shall create a report automatically 
once the batch has finished.

Version Provide a version for the draft of the Master Recipe like “D1.0”. 
Formulation does not imply any syntax or force any rule on the 
version string. The version can be up to 8 characters long.
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Amount Specify the Norm Amount for which you will give the parameter 
values later. Min. Capacity and Max. Capacity are inherited from 
the Master Procedure.

The Norm Amount is not the actual amount that will be created when running a 
batch! For example: In a recipe from a cooking book the ingredients are specified 
for a certain number of persons. Let’s say 2. So the Norm Amount for the 
cooking recipe would be 2 persons. But when you do the cooking, you may cook 
for 10 persons instead. As a recommendation you could use the Min. Capacity as 
the Norm Amount. If Min. Capacity is 0.0 use 1.0 as the Norm Amount.

Optional header information is:

Description Holds up to 256 characters that describe the recipe.

Report This field holds the template for creating a batch report. By default 
the entry will point to the template directory under the Formulation 
installation directory. It is an Excel file, whose header page can be 
modified to adjust to company, site or other information. See 
Customize the report template on page 77.

Life Cycle This is filled automatically with the name of the user that created 
the recipe and date and time of the creation.

Product Specify the name of the product that will be created by this recipe. 
For information purposes only.

Product Code If the product has a special code you can additionally specify it 
here.

Process Station 
Shows the process station this recipe will run on. Is inherited from 
the belonging Master Procedure.

FPX Tag Shows the FPX function block associated with the SFC that runs the 
recipe. Is inherited from the belonging Master Procedure.
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4.11 Add parameters to Master Recipe
The parameters of a recipe hold values that will be written to variables inside the 
controller running the SFC. Those variables usually are set points for dosing 
functions and thereby determine the amount of product produced, but it can also be 
temperature set points for heating and cooling, stir frequencies or durations for 
reactions. It totally depends on what the variables in the SFC are used for. Even 
structural process changes can be accomplished if the variable influences transition 
into alternate branches.

The meaning of parameters is determined how their belonging variables are used in 
the SFC application inside the controller, not by the configuration in the Master 
Recipe. Formulation allows associating controller variables with parameters of a 
recipe. 

1. Select the Parameter tab of a Master Recipe.

Empty_Parameter_tab.png

2. Click Add link in the table, or select any existing parameter and right-click, then 
select Add from the context menu. The Add Parameters dialog will appear.
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Add_Parameter_dialog.png

The dialog shows global variables from the project, which are available for the UNI-
GWY after the download from Freelance Engineering. By default, Structured 
Variables only is selected.

If the recommendation to use structured variables for the SFC was followed then 
simply click on the structured variable that holds the variables to be used by this 
recipe, otherwise you will have to select all the variables separately. It helps greatly 
if the variable access for the UNI-GWY is restricted to those variables that will be 
used by a recipe within Formulation. Doing so will reduce the number of variables 
in the Add Parameter dialog.

Columns in the parameter table

Name By default is filled with name of the associated variable. If the 
variable name was already meaningful it can help to find a proper 
parameter name. The name can have up to 64 characters.

Description A short text of up to 256 characters describing the parameter.

Variables of data type DT (Date&Time) are not supported as parameters.
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Data Type It is the type of the associated variable. This cell is filled 
automatically and cannot be edited. Data type DT (Date&Time) is 
not supported.

Limit Low The smallest value that this parameter can have in the recipe. If the 
parameter is scalable (see below) then this should represent the 
value to produce an amount of Min. Capacity. Otherwise it should 
contain the smallest meaningful value or a physical limit or scale 
start for a variable based on a physical input.

When the value of the parameter is changed, it is checked against 
the Limit Low. See column Severity below

Norm Value The value of the parameter needed to produce the Norm Amount of 
the recipe.

Limit High The highest value that this parameter can have in the recipe. If the 
parameter is scalable (see below) then this should represent the 
value to produce an amount of Max. Capacity. Otherwise it should 
contain the biggest meaningful value or a physical limit or scale end 
for a variable based on a physical input.
When the value of the parameter is changed it is checked against the 
Limit High. See column Severity below.

Engineering Unit
Select the unit of this parameter from a list or type your own unit.

Scalable When checked the parameter will be scaled according to Scale 
Factor if the amount to produce is different from the Norm Amount. 
If unchecked the parameter is fixed.

Scale factor Set to 100% by default. If the amount to produce (in the Control 
Recipe) is double of the Norm Amount in the Master Recipe, then a 
Scale Factor of 100% means the parameter value will also double. 
This cell accepts unsigned integer values from 0 to 100. A value of 
0 is similar to uncheck the scalable checkbox. 
See also Scaling on page 62.
 Engineering - Formulation 59



Data Presentation rules 4  Use of Formulation
 

Severity If a change of the parameter value (either through scaling when the 
Control Recipe is created or when adjusting a parameter while the 
batch runs) violates a limit (Limit Low or Limit High) the value of 
Severity determines how Formulation treats the violation. By 
default this attribute is set to Error.

Severity = Warning
The parameter will be flagged by a yellow triangle in front of the 
parameter value. The parameter can still be downloaded or adjusted.

Severity = Error
The Parameter will be flagged by a red stop sign in front of the 
parameter value. It will not be possible to download or adjust the 
parameter.

VariableName 
This is filled automatically with the variable name from the project 
associated with this recipe parameter. 

4.11.1 Data Presentation rules 

Entering or displaying values of certain data types will follow rules. When those 
rules differ from the rules in Freelance it is done for more easy use and described in 
this section.

Float/Real

Floating point values can have a lot decimals when presented at the graphical user 
interface, especially as a result of the scaling discussed in the next chapter. While 
the accuracy increases with the number of decimals the readability and usefulness 
decreases. Therefore Formulation limits the number of decimals that will be 
accepted as user input and that will be presented to the user according to the table 
below.

Value Range Format

0...1 0.#### (4 decimals)

1...10 #.### (3 decimals)
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Those formatting rules apply to all values of data type FLOAT32, like Min./Max 
Capacity, Amount, NormValue, Conf.Value, New Value, Low Limit, and High 
Limit.

Time

Time values are used to specify duration. The format to enter them is

dd-hh:mm:ss

with 

dd number of days from 0 to 23

hh number of additional hours from 0 to 23

mm number of additional minutes from 0 to 59

ss number of additional seconds from 0 to 59

Data type DT is not supported because it does not make sense as a parameter.

BOOL

While Freelance Engineering and Freelance Operations expect a TRUE or FALSE, 
Formulation uses 1 and 0 to specify the value of a boolean variable. This shortens 
the number of buttons to type to enter the values.

1 equals TRUE

0 equals FALSE

10...10,000 ##- #.## (2 decimals)

> 10,000 #-## (No decimals)

It is not necessary to type a decimal point like in Freelance Operations or 
Freelance Engineering to specify a float value. Formulation will automatically 
format the input according to above table.

Value Range Format
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4.11.2 Scaling

Some parameters will have to change, when the amount of the product to produce is 
changed. Those parameters are scalable. Some parameters are independent from the 
amount of product produced, those parameters are fixed.

Example: In a recipe for baking bread, the parameter that holds the amount of flour 
needed to produce the dough depends on the amount of bread to produce and is 
therefore scalable. The temperature for baking the bread is independent from the 
amount of bread produced and is therefore fixed.

If a parameter is scalable Scale Factor will determine how much the value changes. 
If the amount to produce in a Control Recipe is N-times the Norm Amount of the 
Master Recipe the a Scale factor of 100% means that the parameter value in the 
Control Recipe will also be N-times the Norm Value of the parameter in the Master 
Recipe.

The formula used for calculating the scaled parameter value is

If the scaled parameter value has to be K-times the norm parameter value, the 
Scale Factor can be calculated like this:

Example 1: Let's assume that in case we produce 10 times the Norm Amount we 
know that we also need 10 times the parameter value then 
(AmountCurrent)/(AmountNorm ) = 10 and K = 10 which leads to ScaleFactor = 1 
which is 100%.

Example 2: Let's assume that in case we produce 2 times the Norm Amount we 
know that we only need 1.25 times the parameter value then 
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(AmountCurrent)/(AmountNorm ) = 2 and K = 1.25 which leads to Scale Factor = 
0.25/(2-1) = 0.25 which is 25%.

The scaling formula is linear, in the sense that independent of the actual amount to 
produce, the Scale Factor is always the same.

Ratio_Graph.png

Above picture shows the curves ratio  as a function of 

for different Scale Factors in steps of 10%. Please note that a Scale Factor of 0% is 
similar to no scaling (A) and that for AmountCurrent = Amount Norm for all Scale-
Factors the parameter value equals the Norm parameter value (B).

Cell that contains the Scale Factor does accept integer values between 0 and 100 
only. 
If the calculation results in a Scale Factor with decimals, then enter the nearest 
integer value!

ParValScaled

ParValNorm
---------------------------------

AmountCurrent

AmountNorm
-------------------------------------
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The picture can be used to approximate the Scale Factor. As an example for 
producing 10 times the Norm Amount but only using 2 times the Norm Value of a 
parameter the Scale Factor should be slightly above 10%.

4.12 Delete a Parameter
Select the parameter and press DELETE on the keyboard, or right-click the 
parameter and select Delete from the context menu.

4.13 Copy and paste parameters between Master Recipes
Formulation allows parameters to be copied between Master Recipes under the 
same or different Master Procedures.

Certain data types like BOOL or STRING cannot be scaled. Data type TIME 
(duration) will be internally expressed in multiples of one millisecond and can 
thus be scaled.
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1. Open the Parameter tab of the source Master Recipe, and select parameters to be 
copied. SHIFT and CTRL can be used for quick selection.

Copy.png
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2. Right click on the selected parameters and click Copy in the context menu.

select parameteres.png
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3. Open the Parameter tab in the target Master Recipe and right click.

parameter tab.png
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4. Click Paste and the selected parameters will be pasted to the target Master 
Recipe. The parameters are added at the end of already existing parameters of the 
recipe. 

paste.png

If one or more parameters with the same variable did already exist in the target 
recipe, the message below will pop up and no parameters will be pasted.
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If after the paste the total number of parameters would exceed 300, the message 
below will pop up and no parameters will be pasted.

 
4.14 Add report items to Master Recipe 

While parameter carry values that influence the way the batch is produced, report 
items carry metrics that allow judging the quality of the batch. Also report items are 
associated with global variables in the controller. But while variables associated 
with parameters are variables read by functions or function blocks, variables 
associated with report items are written by the output of functions or function blocks 
in the controller.

Report items are created similar to parameters.

Select the Report Items tab of a Master Recipe.

Note that parameters are also part of the report by default. So the report items are 
reported in addition to the parameters.
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 Report_items.png

Click Add link in the table, or select any existing report item and right-click, then 
select Add from the context menu. The Add Report Items dialog will appear.
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Add_Report Items Dialog.png

The dialog shows global variables from the project that are available for the UNI-
GWY after the download from Freelance Engineering. By default the Structured 
Variables only is selected. If the recommendation to use structured variables for the 
SFC was followed then simply click on the structured variable that holds the 
variables to be used by this recipe for report items, otherwise you will have to select 
all the variables separately. It helps greatly if the variable access for the UNI-GWY 
is restricted to those variables that will be used by a recipe within Formulation. 
Doing so will reduce the number of Variables in the Add Report Items dialog.

Columns in the Report Items table:

Name By default is filled with name of the associated variable. If the 
variable name was already meaningful it can help to find a proper 
report item name. The name can have up to 64 characters.

Description A short text of up to 256 characters describing the report item.

Data Type Type of the associated variable. This cell is filled automatically and 
cannot be edited.

Good Range Start 
The smallest value for this report item that will seen as good. See 
Good Range on page 72.
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Good Range End 
The highest value for this report item that will be seen as good. See 
Good Range on page 72.

Engineering Unit 
Select the unit of this report item from a list or type your own unit.

VariableName Is filled automatically with the variable name from the project 
associated with this report item. 

Good Range

The configuration of a Good Range helps identifying report items in the report that 
might be responsible for a bad batch quality. Report items that are outside of their 
range will be marked in the report with a red background.

The Good Range is not scaled! Therefore make sure that the report item is 
independent of the amount of product created by the batch, otherwise the Good 
Range will become too big and does not make sense.

Example: Instead of reporting the difference between the set point and the measured 
fill level of a tank used during the batch process, better report the difference in 
relation to the set point.

This way the reported deviation is independent from the absolute fill level and a 
narrow Good Range can be configured.

Those calculations need to be performed in the controller, because Formulation only 
reports the value as it reads it.

4.15 Copy and paste report items between Master Recipes
Formulation allows report items to be copied between Master Recipes under the 
same or different Master Procedures.
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1. Open the Report Items tab of the source Master Recipe, and select report items to 
be copied. SHIFT and CTRL can be used for quick selection.

Select report items.png
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2. Right click on the selected report items and click Copy in the context menu.

Copy report items.png
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3. Open the Report Items tab of the target Master Recipe and right click.

Report Items tab.png
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4. Click Paste and the selected report items will be pasted to the target Master 
Recipe.

Paste report items.png

If one or more parameters with the same variable did already exist in the target 
recipe, the message below will pop up and no report items will be pasted.
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If after the paste the total number of parameters would exceed 300, the message 
below will pop up and no report items will be pasted.

 
4.16 Customize the report template 

Reporting is done using an Excel template. The Template is called Batch Report 
Template.xls and is located in the directory Template under the Formulation 
installation directory. By default the path is

C:\FreelanceData\Formulation\Template

The first sheet of the report template can be modified to accommodate general 
information about the company and recipe.

The second sheet is locked and will contain parameter and report item when the 
report is generated.
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Report Template Sheet 2.png

Excel 97-2003 is used to save batch reports of Formulation. Please make sure that 
the two options Open and Save for Excel 97-2003 Workbooks and Templates are 
unchecked, otherwise, batch reports cannot be generated automatically.

Confirm the settings:

Open Excel > File > Options > Trust Center > Trust Center Settings... > Excel 97-
2003 Workbooks and Templates

4.17 Advance the Life Cycle of Master Recipe
Right-click on a Master Recipe in the tree and select the Life Cycle entry to see the 
possible commands available for advancing the Master Recipe’s life cycle.
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Master Recipe Header Life Cycle .png

A Master Recipe has 5 life cycle states: Draft, Approved, Released, Effective and 
Withdrawn.

Master_Recipe_ Life Cycle .png
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4.17.1 Draft State

This is the default state after inserting a Master Recipe or after pasting a copy. In 
this state you can add or delete parameter or report items and edit header data, 
parameter and report items.

4.17.2 Approved State

If all the parameters and report items are configured correctly the Master Recipe 
should be brought to the Approved state.

If User Management is enabled the approve dialog will ask for a signature (user 
name and password) and allow changing the version. The user that signs the 
approval needs to have approval permission! The signing user’s name is shown in 
the life cycle table together with date and time of the signature.

Without User Management enabled no signature will be asked for and the default 
user NOLOCK appears in the life cycle table as the approving user.

If any changes are done to an approved Master Recipe, it will go back to the Draft 
state automatically.

4.17.3 Release State

A released Master Recipe is also visible in the Operation mode of Formulation, but 
no Control Recipes can be created yet. This state can be used by shift leaders or 
senior operators to prevent new creations of Control Recipes for the Master Recipe 
while existing Control Recipes can still be used to run batches.

If User Management is enabled the release dialog will ask for an electronic 
signature in form of user name and user password. The signing user’s name is 
shown in the life cycle table together with date and time of the signature.
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Without User Management enabled no signature is asked for and the default user 
NOLOCK will be shown as the one who “signed” the release.

If changes are done to a released Master Recipe Formulation will automatically 
create a copy of the Master Recipe with the changes. The copy will then be in Draft 
state again and can be edited. This has the advantage that on one hand you can 
continue to run already created Control Recipes and on the other don’t have to wait 
changing the Master Recipe until all Control Recipes are finished.

4.17.4 Effective State

To reach this state a released Master Recipe needs to be deployed. In the Effective 
state Control Recipes can be created in the Operation mode of Formulation. 

If User Management is enabled the deploy dialog will ask for an electronic signature 
in form of user name and user password. The signing user’s name is shown in the 
life cycle table together with date and time of the signature.

Without User Management enabled no signature is asked for and the default user 
NOLOCK will be shown as the one who “signed” the deployment.

If changes are done to an effective Master Recipe, Formulation will automatically 
create a copy of the Master Recipe with the changes. The copy will then be in 
Draft state again and can be edited. This has the advantage that on one hand you can 
continue to run already created Control Recipes and on the other don’t have to wait 
changing the Master Recipe until all Control Recipes are finished.

4.17.5 Revoke a Master Recipe

Revoking an effective Master Recipe will bring it back to state Released. See 
Release State on page 80. This is useful if already created Control Recipes need to 
be executed but no new Control Recipe must be created.
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4.17.6 Withdrawn State

A Master Recipe in the state Approved, Released or Effective can be withdrawn. 
Precondition is that no Control Recipe does exist for this Master Recipe or all 
existing Control Recipes are in state Finished.

If User Management is enabled the withdraw dialog will ask for an electronic 
signature in form of user name and user password. The signing user’s name is 
shown in the life cycle table together with date and time of the signature.

Without User Management enabled no signature is asked for and the default user 
NOLOCK will be shown as the one who “signed” the withdrawal.

No changes can be done to a withdrawn Master Recipe. Deletion or copying is 
allowed. Copy and Paste will create a copy of the Master Recipe in the draft state.

4.18 Delete a Master Recipe
A Master Recipe can only be deleted in the state Draft or Withdrawn. In the latter 
case, to be able to delete it, no Control Recipe for the Master Recipe must exist or 
all existing Control Recipes are in state Finished.

4.19 Archive a Master Recipe
A Master Recipe can be archived in the state of Draft or Withdrawn in configuration 
mode. Users can archive the Master Recipes that are no longer needed. Archiving a 
Master Recipe can only be processed in Formulation server station. Archiving offers 
the option to automatically delete the archived Master Recipe.
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1. Right click the Master Recipe to be archived, or select the Master Recipe and then 
select Archive MR from the File menu.

Archive MR 1.png

Archive MR 2.png

2. Click Archive MR and select the destination folder.
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 Destination folder for archiving MR

Modifying archived Master Recipes in the archive file renders the archive non-
restorable.

The default folder is C:\FreelanceData\Formulation\Archive

The default file name is [Master Recipe Name]_[Master Procedure Name]_[Archive 
Date]_[Archive Time].csv

3. The Master Recipe can be either deleted or kept in the Formulation after 
archiving successfully.
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4.20 Restore a Master Recipe
When an archived master recipe needs to be used again, it can be restored. Restoring 
a Master Recipe can only be processed in a Formulation server station.

1. Right click the Master Procedure under which the Master Recipe should be 
restored, or select the Master Procedure and then select Restore MR from the File 
menu.

Restore MR 1.png

Restore MR 2.png

2. Select the archived Master Recipe to be restored and click Open.
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 Restore MR

3. Comfirm the file information of the Master Recipe displayed in the dialog below. 
When the information is correct, click Restore. The MR name can be modified in 
case a Master Recipe with the same name does already exist below the Master 
Procedures.
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Master Recipe information.png

4. If the Master Recipe is restored successfully, the message below will pop up.

Master Recipe restored successfully.png

If the Master Recipe is corrupted, the dialog as below will pop up .

restore failure.png

The Master Recipe will be restored in state DRAFT.

If FPX tags and/or the process stations of the archived Master Recipe and the target 
Master Procedure are different, the dialog below will pop up.

Different FPX tags or process stations.png

If select Yes, FPX tag and/or the process station of the target Master Recipe will be 
applied to the restored Master Recipe. Since the target process station or FPX tag 
are different from the original archive Master Recipe, the variable names of 
parameters and Report Items might need to be changed also.
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4.21 Set the Auto-ID rule

When Control Recipes are created a Batch-ID is automatically assigned. The rule 
how to create a Batch-ID can be configured in the Define Batch-ID Auto-
Generation dialog.

Batch-ID_ Auto-Generation_Dialog.png

The Batch-ID can consist of up to 5 parts which can be configured individually. The 
parts can be separated by configurable separators.

Each part can contain one of several predefined contents.

If Formulation finds that a Batch-ID generated already exists, it will add an 
incremental number at the end of the Batch-ID, thus making the Batch-ID 
unique.

Formulation does not keep a record of all Batch-IDs it has ever created. 
Formulation will only recognize duplicate Batch-IDs if the Control Recipe 
tagged with the original Batch-ID does still exist. Therefore make sure to use 
functions like Date and Time to make a duplicate Batch ID impossible.
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Auto-Generate_function_list.png

Text This is function takes the free configurable text entered in the Input 
field below the list as part of the Batch ID. It is useful if the Batch-
ID needs to contain some constant string like the company name for 
example.The text can consist of up to 25 characters.

Author The currently logged-in user name will be used to create this part.

Counter Provides a number created by an endless counter. Every time the 
dialog is closed with pressing the OK, the counter is reset to 1. The 
format of the counter value that gets inserted as part of the Batch-ID 
can be selected from the format list that will be active when the 
function Counter has been selected.

“#" stands for a digit of the counter value. Without a leading 0 the 
number of digits used depends on the counter value. The option 
#### will create numbers: 1, 2...9, 10...99,100...999, 1000...9999 
The option 0#### will create 0001, 0002...0009, 0010...9999.
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After 9999 the counter will overflow to 0 resp. 0000 and then restart 
with 1 resp. 0001.

Because the counter is reset to 1 when closing the Define Batch-ID Auto- 
Generation dialog, after overflow and at midnight, counter values are not unique. 
Make sure to use functions like Date and Time together with the counter 
function to make a duplicate Batch-ID unlikely. Together with the automatic 
duplicate detection of Formulation based on still existing Control Recipes this 
will ensure that each Batch-ID is unique.

Counter24 Provides a number created by a counter that resets on midnight 
every day. Every time the dialog is closed with pressing the OK the 
counter is also reset to 1. This function can be used to count the 
Control Recipes on a daily basis. 

The format of the counter value that gets inserted as part of the 
Batch- ID can be selected from the format list that will be active 
when the function Counter has been selected.

A "#" stands for a digit of the counter value. Without a leading 0 the 
number of digits used depends on the counter value. The option ## 
will create numbers 1, 2...9, 10...99. The option 0## will create 01, 
02...09, 10...99 After 99 the counter will overflow to 0 resp. 00 and 
then restart with 1 resp. 01.

Because the counter is reset to 1 when closing the Define Batch-ID Auto-
Generation dialog, after overflow and at midnight, counter values are not unique. 
Make sure to use functions like Date and Time together with the counter 
function to make a duplicate Batch-ID unlikely. Together with the automatic 
duplicate detection of Formulation based on still existing Control Recipes this 
will ensure that each Batch-ID is unique.

Master Recipe Name 
The name of the Master Recipe the Control Recipe belongs to.
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Date The date according to the PC real time clock in the Format 
YYYYMMDD or YYMMDD depending on the selection in the 
Format field. This date format is chosen to allow for easy sorting of 
the Control Recipes and their reports.

Time The time according to the PC real time clock in the Format 
hh:mm:ss.

Product Code The text from the Product Code field in the belonging Master 
Recipes header data.

Product Name The text from the Product Name field in the belonging Master 
Recipes header data.

Master Procedure Name
The name of the belonging Master Procedure.

Not Used When selected this part is not used to build the Batch-ID.

4.22 Create a Control Recipe 
Control Recipes can only be created in the Operation mode.

A Control Recipe is a recipe that must be used to run a batch inside the controller. 
The Control Recipe is created from a Master Recipe by specifying the amount of 
product to create. The parameters of the Master Recipe are scaled to match the 
intended production amount.

1. Start Formulation.

2. Make sure the mode Operation is selected.

3. Select a Master Recipe in Effective state .

4. Right-click on the Master Recipe to show the context menu.

5. Select Insert Control Recipe from the context menu.

6. The Create Control Recipe dialog opens.
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Create_ Control_ Recipe_Dialog.png

A Master Recipe can have up to 30 Control Recipes only. If the sum of the 
Control Recipes to create plus the already existing Control Recipes for that 
Master Recipe would exceed the 30 Control Recipes permitted, a dialog will 
inform about the situation and no Control Recipe is created.

Enter the intended amount to produce into the cell Amount or use the slider.

New Control Recipe(s) [CR] with the default name(s) New Control Recipe (##)_K 
of L will be created.

(##) In case the default name New Control Recipe does exist already, the 
next creation will add an incremental count to the name.

K of L If multiple Control Recipes are created in a single creation process 
(Amount specified is bigger than Max Amount) the group of 
Control Recipes can be identified by “K of L”, where K is the 

By directly entering into the cell you are able to specify an amount bigger than 
Max. Capacity. In that case Formulation will create more than one Control 
Recipe so that the sum of all Control Recipes created will match the specified 
amount.

A dialog will pop up to inform about the multiple creation.

Formulation will detect that the Batch-ID of the multiple instances would not be 
unique and will add an incremental number for the second Control Recipe and 
higher.
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running number and L is the final number of Control Recipes 
created. 

Example: If Max Amount is 100 ton and you specify to create 500 
ton, then L =5 and 5 Control Recipes will be created with the names 
ending in ...1 of 5, ...2 of 5, ...3 of 5, ...4 of 5, …, 5 of 5.

The tab CR Header is preselected.

4.22.1 Header Tab

Control_Recipe_Default_Header_ Data.png

Generate Batch ID 
In case the default Batch ID needs to be changed a new Batch-ID 
can be generated by pressing this button.

Control Recipe 
Enter the name of the Control Recipe

Description A text describing the Control Recipe in more detail
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Report Generation 
By default this field is inherited from the Master Recipe. It is 
possible to check or uncheck the automatic report generation.

FPX Mode Shows the current Mode (Operator, Program) of the belonging FPX 
function block. This information helps to analyze why the 
download for a Control Recipe might not be enabled

FPX State Shows the current state (Idle, Running, Complete, Held, Stopped, 
Aborted, Pause) of the belonging FPX function block. Besides 
giving information about the state the batch is in the information 
also helps to analyze why the download for a Control Recipe might 
not be enabled.

Version Provide a version for the draft of the Master Recipe like “1.0”. 
Formulation does not imply any syntax or force any rule on the 
version string. The version can be up to 8 characters long.

Life Cycle The Control Recipe is checked during creation, after the parameters 
have been scaled. So the default Life Cycle state is Checked.

Product Name This field is inherited from the Master Recipe.

Product Code This field is inherited from the Master Recipe.

Process Station 
Name of the process station that contains the SFC that will run the 
batch. This field is inherited from the Master Recipe.

FPX Tag Name of the FPX function block that is associated with the SFC that 
will run the Batch. This field is inherited from the Master Recipe.

Master Recipe Name of the Master Recipe this Control Recipe was created from. 
This field is filled automatically.

Amount The amount of product to be produced by this Control Recipe.

If during creation of the Control Recipe an amount greater than Max. Amount 
was specified, then the Amount value in the Control Recipe header only shows 
part of the specified amount because more than one Control Recipe was created.
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4.22.2 Parameter Tab

Control_Recipe_Parameter_tab.png

Compared to the Parameter tab of the Master Recipe the title of the value column 
has changed from Norm Value to Conf. Value. This is due to the fact that the 
parameters in the Control Recipe are scaled due to the configured amount of the 
Control Recipe.

Also the result of the checking against the limits can be seen in a new Check 
column. If the check result of a parameter is Warning or Error a small icon in front 
of the Conf.Value draws the attention to those values.

Warning Icon: 

Error Icon:

The summary of the check result can be seen in the tree and header icon of this 
Control Recipe. The summary result is worst result of all check results. If from 100 
parameters 5 have warnings and one has an error, then the summary check result is 
Error.

If the summary result is Warning or OK, the Control Recipe can be downloaded to 
the controller, provided the FPX function block is in state Idle and the FPX function 
block mode is Program.
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Only Conf.Values can be changed in this view. Everything else is inherited from the 
Master Recipe.

4.23 Advance the Life Cycle of Control Recipe

Advance the Lifecycle.png

The Control Recipe has 5 states: Draft, Checked, Ready, Executing and Finished.

4.23.1 Checked State
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This is the default state after inserting a Control Recipe. In this state downloading 
the Control Recipe to the controller (=write the parameter values to the 
corresponding global variables) is possible.

Formulation will check the scaled parameters against their limits when the Check 

 is clicked or as part of creating a new Control Recipe. 

In case of a limit violation it will create an Error or a Warning. The result of the 
individual checks can be seen in the Parameter tab. The tree icon and the header 
tab icon will show the summary result.

A summary result of Warning  will still allow downloading the recipe.

Formulation will check if the FPX state is Idle and the mode of the FPX is 
Program. Only then will the download be allowed.

A successful download advances the life cycle state to Ready.

4.23.2 Draft State

When a Conf. Value is edited the Control Recipe moves back to the Draft state. 
Press the Check  will bring it back to the Checked state.

4.23.3 Ready State

This state marks a successful download of the Control Recipe to the controller. 
From here on the Conf. Value of the Control Recipe is frozen. Parameter changes 
are still possible, but do not change the Conf. Value in the Control Recipe. Instead 
the changes apply to the variables inside the controller only.
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Control_Recipe_Parameter_view.png

The Parameter tab has two new columns:

Curr. Value Shows the current online value of the variable associated with a 
parameter. If the current value differs from the configured value 
both values are shown with a yellow background.

New Value Allows providing new values for the variables inside the controller. 
The new values are only downloaded to the controller when the 
Download  is pressed. 

This allows for a consistent download of multiple values.

From the Ready state on advances in the life cycle state of the Control Recipe 
depend on the FPX function block. See for example starting the Batch via the FPX 
faceplate would advance the Control Recipe state to Executing.

4.23.4 Executing State

In this state Formulation is monitoring the FPX state in order to adjust its own life 
cycle state. Changing of parameters is possible but will be applied to the controller 
only.
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The Control Recipe cannot be deleted in this state. When the FPX function block 
state changes to Completed, Aborted or Stopped, the Control Recipe will advance 
its life cycle to Finished.

4.23.5 Finished State

On entering the Finished state the batch report is created. Every Control Recipe can 
be executed only once, so the Finished state marks the end of the life cycle of a 
Control Recipe.

In this state the Control Recipe can be deleted.

4.23.6 Check the control recipe

After creation the Control Recipe is automatically checked. A new check is needed 
once a parameter value has been changed.

Press the Check  in the toolbar or right-click on the Control Recipe in the tree 
and select Check from the context menu.

4.23.7 Changing parameters

Changing parameters of a Control Recipe can be separated into offline changes, 
which are stored in the Control Recipe and online changes which are stored in the 
global variables inside the controller only.

Changing Control Recipe Parameters Offline

In life cycle state Checked and Draft of a Control Recipe the only offline changes 
can be done entering the new value directly in the Conf.Value column of the 
Parameter tab.

Formulation will automatically reset the FPX after it has created the batch report. 
This will move the FPX function block to mode Program and state Idle then the 
next Control Recipe can be selected for download.
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Edit_Parameter_Offline.png

The Control Recipe life cycle state will change to Draft if a parameter has been 
changed.

Changing Control Recipe Parameters Online

When successfully downloading a Control Recipe, the values in the Conf.Value 
column are frozen and cannot be changed anymore. From then on (life cycle states 
Ready and Executing) only online changes can be done by entering the new value 
in the New Value column.
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Edit_Parameter_Online.png

The change becomes active by pressing the Download  in the toolbar. 
Formulation will write the values to the associated global variables in the controller. 
On a successful download the new values will appear in the column Curr.Value. 
The configured values in the Conf.Value column will not be changed.

If for a row the values of Conf.Value and Curr.Value differ, both cells are 
highlighted with a yellow background to mark deviations from the Control Recipe.

It is possible to enter new values for multiple parameters and downloading them all 
together in a consistent way with a single download.

For both types of changes, offline as well as online changes Formulation will check 
the new value against the limits configured for the parameter in the Master Recipe.

If the value violates the limits, the violation is treated depending on the value of 
Severity.

Severity = Error 
An error symbol will appear in front of the value and Error 
will be written in the Check column for this parameter. 
Downloading this parameter will not be possible.

Severity = Warning 
A warning symbol will appear in front of the value and Warning 
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will be written in the Check column for this parameter. 
Downloading this parameter will be possible.

Formulation will always treat all parameters in the set of parameters to download 
in the same way to preserve consistency.

If doing offline changes not a single parameter must have an error, otherwise no 
download is possible

If doing online changes for multiple variables, no single parameter must have an 
error; otherwise no parameter will be downloaded, even when it is OK.

4.23.8 Download the Control Recipe

Formulation requires certain conditions to allow downloading a Control Recipe.

1. The Control Recipe has to be in life cycle state Checked or Ready.

2. No parameter error must be present. Warnings are allowed.

3. The FPX function block that is associated with the SFC that will run the batch 
needs to be in Idle state.

4. The FPX function block needs to be in Program mode.

All four Conditions need to be matched to allow the download.

To execute the download

– If User Management is enabled, make sure you have Operation rights.

– Make sure Formulation is in Operation mode.

– Select the Control Recipe in the tree.

– Press the Download  in the toolbar or right-click on the selected 

Control Recipe in the tree and select the Download menu.

Reasons for the unsuccessful download of variables will be shown in the download 
result.

Download result.png
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In case the Control Recipe selected is already in Ready state, which means it was 
downloaded already but has not been started yet, Formulation will ask the user what 
to do.

• If the Control Recipe selected for download is the same Control Recipe that 
had already been downloaded the user has the option to re-download the 
parameters.

• If the Control Recipe selected is another Control Recipe than the one 
downloaded already, the user has the option to overwrite the current download. 
The overwritten Control Recipe will be set back to Checked state.

Formulation writes all parameter values of the selected Control Recipe to the global 
variables associated with the parameters. Next Formulation verifies that all 
associated global variables have the correct values by reading them and comparing 
them against the values in the Control Recipe.

Only if the values match, a success dialog will be presented and the life cycle state 
of the Control Recipe advances to Ready.

If an error happens, the dialog will show the Failed information. Check the 
parameter tab of the Control Recipe. It will show current values (in the controller) 
and configured values (in the Control Recipe) in two adjacent columns Curr. Value 
and Conf. Value. If the values differ, the background of the cells holding the two 
values will be highlighted with yellow color.

If single variables failed, try the download again. If the same variables fail again, 
verify that those variables do exist in the controller. Maybe the variables have been 
renamed inside the controller or the data type has been changed. In that case the 
Master Recipe needs to be corrected.

If most or all variables fail, check whether the UNI-GWY representing Formulation 
in the project has been downloaded and that the variables have read/write access in 
the UNI-GWY. See for information, Adding a UNI-Gateway to the project on page 
29, Variables on page 31. 

Restart Formulation to make sure that it uses the last downloaded information.

On a successful download Formulation will set the belonging FPX function block 
into Operator mode.

Formulation will not start the batch. The batch has to be started manually.
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4.24 Start a batch
A batch can be started, when the belonging Control Recipe is in Ready state. This 
state is reached by downloading a checked Control Recipe that has no errors. See 
Download the Control Recipe on page 102.

The batch can be started using the FPX faceplate in Freelance Operations. Click 

Start  on the FPX faceplate followed by pressing the Enter button 

The SFC will start and the FPX moves from state Idle into Running state.

After the batch has finished, Formulation will set the FPX mode back to Program. 
Because this will be done after the report is created it might take up to 5 seconds.

Click Root note to open context menu. Select All Executing CRs in the menu, the 
execution of Control Recipes will be listed; select All CRs, all existing CRs listed.

All Executing CRs or All CRs.png

4.25 Changing Formulation Mode 
Formulation has two modes: Configuration and Operation.

Master Procedures and Master Recipes can be worked on in Configuration mode 
only, Control Recipes can be worked on in Operation mode only.
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The current mode can be detected by looking at the mode buttons in the upper right 
side of the Formulation window, or by the color of the background of the tab areas.

To switch to the desired mode left-click on the button with the corresponding name.

If User Management is enabled Operation or View permission is needed to switch 
Operation Mode and Configuration permission is needed to switch to 
Configuration mode.

4.26 Document a Recipe
Recipes can currently not be documented within Formulation, except doing a 
screenshot of Header Data, Parameter and Report Item tab.

In case additional documentation is needed Microsoft Access can be used.

The recipe database is an Access database file called Formulation.mdb that by 
default resides on the server installation in the DBFile directory under the 
installation directory of Formulation. By default the installation directory is 
C:\FreelanceData\Formulation\DBFile.

Instead copy the file and run Access on the copy. Please revert to the Access user’s 
manual on how to use the program for documentation of the databases.

Mode Button Background

Configuration

Operation

It is strongly recommended not to use this file with the Access program because 
changes might be done inadvertently that could damage the database.
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4.27 Open & Print a Report
When the batch finishes (Control Recipe goes to Finished life cycle state) and the 
Report Generation checkbox in the Control Recipe header was set, Formulation will 
create Batch report.

The report is a read only Excel file that cannot be modified.

The report file is placed in the Report directory under the installation directory of 
Formulation. The file is named after the Batch ID of the belonging Control Recipe.

If the filename already exists, “(#)” is added at the end with # being an incremental 
number.

Open the report by using the menu File > Open Report. A file open dialog will pop 
up. If a Control Recipe is selected in the tree, the belonging report file will be 
preselected otherwise select the report file to be opened. Click the Open in the 
dialog.

Open Report Dialog

Reports are created at the station that downloaded the belonging Control Recipe.
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Formulation will open the report with Excel. Use Excel to print the report. Reports 
are not deleted when the Control Recipe is deleted. They need to be deleted 
manually.

4.27.1 Log Files

Reports contain only configured values and final values (values from the time the 
batch completed) for a parameter. If parameters are subsequently changed many 
times those changes are not part of the report.

Those changes can be found in a log file on the server. Each client that uses 
Formulation to modify batch parameters will record those changes in a client and 
batch specific log file on the server.

The log files are stored in the directory 
C:\FreelanceData\Formulation\Log on the server. 

The name of the files consists of the Batch ID followed by the resource ID of the 
client who created it. Therefore if more than one client controlled the batch and did 
changes of parameters more than one log file for this batch can be found on the 
server.

The log files are encrypted, so they cannot be changed. The only way to open them 
is to use the File > Open Log menu within Formulation. A file open dialog will pop 
up. If a Control Recipe is selected in the tree, the belonging log file for the 
requesting station will be preselected otherwise select the report file to be opened. 
Click Open in the dialog.
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 Open_Log Dialog

From there the log file can be printed. Log files are not deleted when the Control 
Recipe is deleted. They need to be deleted manually.
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5  Workflow

This section describes how to combine the tasks to create a workflow. 

5.1 Create your first Recipe 
The assumption is that the Freelance Engineering project has been created, the 
project prepared for the use with Formulation and that Formulation has been 
installed and set up properly.

Those tasks are described in Section 2, Installation, Section 4, Use of Formulation.

5.1.1 Prepare the Master Procedures

For every SFC in your project that will be used to run recipes create a Master 
Procedure. See for procedure, Create a Master Procedure on page 49.

Decide whether you want to keep the SFC names as names for the Master 
Procedures or whether you want to give them different names. Apply this rule 
consistently to all Master Procedures.

Advance the life cycle of all Master Procedures to Ready. See for procedure, 
Advance the Life Cycle of Master Procedure on page 52.

5.1.2 Define the recipes

Best make sure to have the SFC configuration done and tested in Freelance 
Engineering before you start creating Master Recipes, otherwise you will need to 
modify the Master Recipe whenever you add, delete or rename a global variable 
used as parameter or report item later in the SFC.

Create the Master Recipes under the belonging Master Procedures. How to do this is 
described in Create a Master Recipe on page 54, Add parameters to Master Recipe 
on page 57, and Copy and paste report items between Master Recipes on page 72.
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Next set the Master Recipes to Released. How to do this is described in Advance the 
Life Cycle of Control Recipe on page 96. The Master Recipes are now prepared for 
use, but no Control Recipe can be generated by the Operators yet.

Now, before the first Control Recipe is created, it is time to set up the rule for the 
Batch-ID auto generation. This is described in Set the Auto-ID rule on page 88.

5.2 Run your first batch
Before we can run the first batch, we need to create a Control Recipe.those tasks to 
create a workflow.

5.2.1 Control the Batch creation

If we want the operators to create the Control Recipes themselves based on the order 
input, we simply set every Master Recipe to Effective. How this is done is described 
in Advance the Life Cycle of Master Procedure on page 52.

If we want the operators to only run the Control Recipes that are created by a batch 
master or similar, then this person needs permission for configuration too. On a new 
incoming order the master needs to set the related Master Recipe to Effective 
(temporarily) and create the Control Recipe or group of Control Recipes. Then he 
revokes the Master Recipe back to state Released.

This way the operators can run the created batches, but cannot create Control 
Recipes by themselves.

5.2.2 Produce a batch

To run a batch, a Control Recipe is needed. So the first step is to create a Control 
Recipe. How to do it is described in Create a Control Recipe on page 91.

The Control Recipe is checked automatically. Look at the icon of the Control Recipe 
in the tree, it will tell the summary check result:
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If the check result is not OK we might want to look at the parameter tab and correct 
some parameters. How to do this is described in Changing parameters on page 99.

When done with parameter changing and the Control Recipe has been Checked 
again, it can be downloaded. Press the button in the toolbar. 

See Download the Control Recipe on page 102 for more details, especially why the 
Download must be disabled.

The batch has to be started manually. After a successful download Formulation will 
set the FPX function block to Operator. Simply start the batch by starting the FPX. 
For details Start a batch on page 104.

The batch can be controlled by the FPX function block. For more information, refer 
to manual 3BDD011932, Freelance Operations  Operators Manual - New Design 
on how to operate the SFC display in case it is needed to execute steps and 
transitions manually.

When the batch completes normally or is stopped or aborted via the FPX function 
block Formulation considers the Control Recipe finished. It will take over control 
again.

It will create a batch report, provided the Report Generation checkbox in the Control 
Recipe Header was checked. See Open & Print a Report on page 106 on where to 
find and how to print the report.

After creating the report, which might take up to 5 seconds, Formulation will reset 
the FPX, there by putting it back to Program mode and Idle state. The FPX is ready 
for download of the next Control Recipe.


OK. The Control Recipe can be downloaded


Warning. At least one parameter has violated its 
limits, but download is still possible

Error. At least one parameter has violated its 
limits. Download is not possible.
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5.3 Find Running Control Recipes
Click Root note to open context menu. Select All Executing CRs in the menu, the 
execution of Control Recipes will be listed; select All CRs, all existing CRs listed.
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